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About this guide

Target audience
The Meridian Companion DECT Overview guide provides information 
for sales representatives, planners, installers, site maintenance 
personnel and administrators.

Identifying Nortel Networks PBX systems
The following systems are referred to in this guide as Large systems:

• Option 51

• Option 61

• Option 71

• Option 81

• Option 51C

• Option 61C

• Option 81C

The following systems are referred to as Small systems.

• Option 11

• Option 11E

• Option 11C

• Option 11C Mini

• Succession Communication Server for Enterprise 1000
Meridian/Succession Companion DECT Overview
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Call out boxes

CAUTION:  Data loss

This symbol alerts you to a procedure that can result in a loss of 
data.

CAUTION:  Equipment damage
This symbol alerts you to a procedure that can result in equip-
ment damage.

CAUTION:  Electrostatic sensitive device

This symbol alerts you to a procedure that can result in equip-
ment damage due to ElectroStatic Discharge (ESD).

CAUTION:  Service interruption
This symbol alerts you to a procedure that can result in an 
interruption of service.

DANGER:  Electric shock

This symbol alerts you to the risk of a serious injury, or death, 
caused by an electric shock.

DANGER:  Serious injury
This symbol alerts you to the risk of a serious injury, or death, 
caused by an immediate hazard.
553-3601-103 Standard 4.00 June 2001
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WARNING:  Personal injury

This symbol warns you to the risk of a minor or moderate injury 
caused by an immediate hazard.

NOTE
This symbol is used to indicate advice.
Meridian/Succession Companion DECT Overview
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Meridian Companion DECT
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Introduction

The DECT system allows users to move freely about their work sites while 
conducting telephone conversations. DECT is an acronym for Digital 
Enhanced Cordless Telecommunications.

Figure 1 Main parts of the DECT system

The DECT system is in a Large system IPE shelf or a Small system 
cabinet/chassis. The DECT system has four main components:

a. DECT mobility cards

b. base station

c. Optivity Telephony Manager with DECT application

d. handsets
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DECT Mobility Card (DMC8)

Figure 2 DECT Mobility Card

 

The NTCW00AB DMC8 DECT Mobility Card provide an interface between the 
Large system or Small system and the base stations.

A DMC8 supports up to eight base stations.

The DECT system supports a mix of DMC and DMC8. (The DMC is a retired card 
no longer available.)

All DMC8s support an Ethernet connection to the MDECT Manager with an 
NTCW12DA cable. The DMC8 requires a NTCW25AA DECT Manager Ethernet 
(DME) daughterboard installed to support an Ethernet connection.

Each DMC8 is programmed in the Large system and Small system database 
using LD 10.

The DMC8s are interconnected by faceplate cables, allowing them to pass 
information to each other.

DMC8s must be in an IPE shelf in a Large system or a Small system 
cabinet/chassis.

There is no call switching in the DMC8. All call switching occurs within the 
Large system and Small system.

DMC

553-8165.EPS
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DECT Mobility Card options

Figure 3 DMC8 options

The component side of the DMC8 contains jumpers J1, J2, and J3. The 
jumpers indicate card status as follows:

• J1 for pre X11 Rls 23 software or post X11 Rls 23 software

• J2 for a card installed in either Small system or Large system
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• J3 for a card installed in either DECT shelf 0 or DECT shelf 1

• J6 to J9 which select either a V.24 connection or an Ethernet 
connection for the OTM DECT Manager. This allows I/O panel 
connections to support eight signals (four V.24 or four Ethernet).

DECT Mobility Card - Expander (DMC8-E)

Figure 4 DECT Mobility Card - Expander

The NTCW01AB DMC8-E DECT Mobility Card-Expander provides the same 
functions as a DMC.

The DMC8-E has additional circuitry required to regenerate faceplate cable 
signals when a system contains more than eight DMC8s. The DMC8-E also 
connects two shelves or cabinets in a DECT system.

If the DMC8-E is used in an IPE module, it must be located in card slot 8. If 
the DMC-E is used in an Small system cabinet/chassis, it must be located in 
card slot 9, 19 or 29.

Do not install a DMC8 in slot 8 of an IPE module. Do not install a DMC8 in 
slot 9, 19 or 29 of an Small system cabinet/chassis.

DMC8 DMC8 DMC8 DMC8 DMC8 DMC8 DMC8 DMC8
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Cont DMC8-E DMC8 DMC8 DMC8 DMC8 DMC8 DMC8DMC8
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An optional NTCW25AA DME daughterboard is required for Ethernet OTM 
access. The DME daughterboard is not required for serial OTM access.

DMC8 and DMC8-E faceplate features

Figure 5 DMC8 and DMC8-E faceplate features
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Figure 5 shows the following DMC8 and DMC8-E faceplate features:

a. red LED (indicates the same status as all IPE cards)

b. yellow LED (indicates DECT sub-system status)

c. green LED (indicates DECT sub-system status)

d. DMC8 to DMC8 faceplate cable port 

e. DMC8 bypass faceplate cable port 

f. DMC8-E to DMC8-E faceplate cable port 

g. for future use
Meridian/Succession Companion DECT Overview
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Faceplate cables

Figure 6 Faceplate cables

The faceplate cables form the 20 Mb/s bus that connects all DMCs. The 
faceplate cables meet the standard for Unshielded Twisted-Pair category of 
performance 5 (UTP Cat 5).

Signalling and PCM are sent to all DMCs over the faceplate cables, allowing 
a DMC8 to pass a call to another DMC8.

The cables shown in Figure 6 are as follows:

a. DMC8 to DMC8 faceplate cable

b. DMC8 to DMC8-E faceplate cable

c. DMC8 faceplate termination 

d. DMC8 bypass faceplate cable

The DMC8 to DMC8 cable extends the 20Mb/s bus to all DMCs.

The DMC8 to DMC8-E cable extends the 20Mb/s bus past the XPEC card. A 
Small system does not require the DMC8 to DMC8-E cable.
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The DMC8 faceplate termination balances the impedance at either end of the 
20Mb/s bus.

The DMC8 bypass faceplate cable bypasses DMC8s to be inserted in or 
removed from an operational system. The DMC8 bypass faceplate cable is 
shown in Figure 6 on cards 10 and 12.

The DMC8-E to DMC8-E faceplate cable connects two shelves or two cabinets. 
The DMC8-E to DMC8-E faceplate cable is shown in Figure 8 on page 21.

The faceplate cabling layout plan must specify that the DMC8 to DMC8-E 
cable connects into the ports as shown in Figure 6 on page 18.

CAUTION:  Service interruption
Customers must use UTP Cat 5 faceplate cables supplied by Nortel 
Networks. Faceplate termination must be used on the DMCs at both ends 
of the faceplate cabling.
Meridian/Succession Companion DECT Overview
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Inter-shelf or cabinet faceplate connections

Figure 7 Cable ferrites

CAUTION:  Service interruption
The DMC8-E to DMC8-E faceplate cable has four sets of movable 
ferrites. The position of the ferrites on the cable is important. See 
Figure 7. Each end of the cable must have a group of 20 ferrites. 
One quarter the distance from each end of the cable must have a 
group of 10 ferrites. The maximum length of the cable is 1.5 
meters, limiting the position of DECT shelves 0 & 1 to adjacent IPE 
modules or Small system cabinets/chassis.

Group of 20
ferrites

Group of 10
ferrites
553-3601-103 Standard 4.00 June 2001
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Figure 8 IPE inter-shelf faceplate connections

Figure 8 shows the following:

a. DECT shelf 0

b. DECT shelf 1

c. DMC8-E to DMC8-E faceplate cable connection between DMC8-Es on 
DECT IPE shelves.
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Figure 9 Option 11 inter-cabinet faceplate connections

Figure 9 shows the following:

a. Option 11 main cabinet

b. Option 11 expansion cabinet

c. Option 11 second expansion cabinet

d. the DMC8-E to DMC8-E faceplate cable connection between the 
DMC8-Es on the first and the second Option 11 cabinets
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Base Station

Figure 10 Base Station

There are two base station models available: the Companion 4600 which 
supports six active call radio links and the Companion 4610 base station 
which supports 12 active call radio links. The base stations are IP40 
compliant wall mounted transceivers which provide digital radio links to 
handsets. 

CAUTION:  Service interruption
For maximum line length before signal degradation occurs, use UTP Cat 
5 cabling between the base station and the shelf or cabinet. If the line 
length exceeds 100 ohms for the 4610 base station, an external power 
supply must be used. The maximum distance when using external power 
with UTP Cat 5 cabling is approximately 1.7 km.
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The base station has the following features:

a. an RJ45 socket connection to a one meter long UTP Cat 5 cable

b. an RJ45 socket connection to an external or local power supply

c. a green LED (C4600) or a yellow LED (C4610), when lit indicates 
synchronization to its DMC8

d. an one meter long UTP Cat 5 cable connected through an RJ45 wall 
socket and MDF to an IPE I/O panel or Small system cabinet I/O 
panel 

Two sources can power the base station:

• the DMC8 and DMC8-E feeding phantom power over the UTP Cat 5 cable 
signaling pairs, connected to (a) in Figure 10

• a local power supply, connected to (b) in Figure 10

Base stations connected to DMC8 or DMC8-E can use phantom power in some 
conditions and must use local power in other conditions. An application on 
the Optivity Telephony Manager can enable or disable phantom power.

Table 1 shows the maximum number of base stations that can be phantom 
powered by one DMC8 card installed with different types of shelf power 
supplies or cabinet power supplies. The remaining base stations (up to a 
total of eight for each DMC8 card) which cannot be phantom powered can 
be locally powered.

NOTE
The maximum line length for a twelve-channel base station using 
phantom power is 1.0 km. The maximum line length for a six-channel 
base station, regardless of power, or a twelve-channel base station using 
external power is 1.7 km.
553-3601-103 Standard 4.00 June 2001
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Table 1 
DMC8 phantom power base station support

Base station housing

Figure 11 Base station environmental housing

Shelf/Cabinet power Maximum number of phantomed 
powered base stations

IPE shelf with pre-NTRD07 DC PEPS, or 
pre-NTRB46 AC PEPS

Five of any type base stations

IPE shelf with NTRD07 DC and later PEPS, or 
NTRB46 AC and later PEPS

Eight of any type base stations

Option 11 Four of any type base stations

Option 11 Mini Eight of any type base stations

553-8206a.EPS
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The environmental housing is IP66 compliant. 

The housing must be used indoors if a base station is subject to conductive 
pollution, or outdoors if base stations are mounted externally.

The environmental housing kit includes all the relevant cables and 
installation material. 

The environmental housing mounts to existing walls.

Signaling lines provide power to the external base stations.

Base Station cell

Figure 12 Base Station cell

A base station cell is the radio signal area covered by a single base station. 
The base stations are positioned so that the cells overlap. A DECT handset 
can make and receive calls when it is within a base station cell. When the 
handset moves from one cell to another, the cell overlap allows the handset 
to move without interruptions.
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The cell radius varies from 20m to 100m.

The number of base stations needed to cover a certain area depends on many 
factors, such as:

• size of the area of coverage

• radio propagation characteristics of the buildings

• materials used for walls, floors, lift shafts, reinforced glass, doors 

• strong magnetic fields from radar, welding equipment, manufacturing 
equipment, and high energy electronic devices

• density of telephone users in an area and the amount of 
telephone traffic
Meridian/Succession Companion DECT Overview
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DECT handsets

Four handset models are available: the C4010, C4010 Ex, C4020, and the 
C4050. The handsets are battery-powered, pocket -sized portable 
telephones.

Subscription and De-subscription

Subscription is the process of adding a handset to a DECT system. The 
handset can then make and receive calls.

A user can subscribe a handset to more than one DECT system. This feature 
is very useful for a company that has multiple DECT sites. See Multi-Site 
Mobility Networking (page 139).

De-subscription is the process of removing a handset from a DECT system. 
The handset user is then prevented from making and receiving calls.

NOTE
Refer to the C4010/C4020 Cordless Handset User Guide, and the C4050 
Cordless Handset User Guide for a detailed description of how to use 
handset features and the features available from the Large system and 
Small system.
553-3601-103 Standard 4.00 June 2001
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The DECT C4010 handset, C4010 Ex handset, and
 C4020 handset

The C4010 is the base model. The C4010 Ex and C4020 handsets have 
additional features or features that are different from the C4010 model. The 
C4010 Ex design allows it to operate safely in an explosive atmosphere. The 
C4020 can accept a headset and has a vibrate alert feature.

Figure 13 DECT C4010 handset and C4010 Ex handset

Handset attributes

• up to 10 hours speech time capacity
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• up to 100 hour standby mode capacity

• up to eight days power-save standby mode (cannot receive calls in this 
mode)

• subscribe to a maximum of eight DECT systems

• directory dialling from a 20-name phone book

• off-hook number preparation with correction option

• last number re-dial

• recall

• automatic encryption

• adjustable alerter volume

• adjustable ear-piece volume in 5 steps

• six ringing melodies

• manual ringer mute on incoming calls

• handsfree operation (C4010 only)

Power supply

• 3.6V/600mAh NiMh rechargeable battery pack

Dimensions

• handset 135 x 58 x 19 mm

• charger 85 x 75 x 50 mm

Color and finish

• the C4010 and C4020 handset color is charcoal, the finish is non-gloss

• the C4010Ex handset is yellow

Weight

• handset 135 g

Accessories

• belt clip

• headset for the C4020 only
553-3601-103 Standard 4.00 June 2001
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Figure 14 C4010 battery charger

C4010 battery charger

• desktop or wall mounted battery charger

• mains supply required is 230V/50 Hz

• power consumption 
Meridian/Succession Companion DECT Overview
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The DECT C4050 handset

Figure 15 DECT C4050 handset

Handset attributes

• up to nine hours speech time

• standby time of up to 130 hours

• subscribe to a maximum of 10 DECT systems

• local directory with alpha search function for 100 entries

• incoming call indication LED light-ring (red)

• charging indication LED light-ring (green)

• visual and audible incoming call signal

553-A0079
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• volume control during a call

• display of name of 16 characters and number of 32 digits

• last number redial of up to 20 entries

• caller list of 20 calls

• caller filter for 10 entries with on/off settings

• re-dial function with 20 entries

• on-hook number preparation

• microphone mute

• display prompts in ten languages

• Calling Line Identification (CLID) 

• key click on or off

• automatic off-hook on an incoming call, selectable

• keypad lock

• headset option

• ringer, 30 melody selectable

• ringer volume control, off, plus seven steps

• tone ringing through the headset in normal speech volume

• ringer mute while charging, selectable

Power supply

• two standard AAA 650 mAh NiMh rechargeable batteries

Dimensions

• handset 140 x 51 x 25.5 mm

• charger 130 x 82 x 65 mm

Color and finish

• the handset color is dark grey and silver with a non-gloss finish
Meridian/Succession Companion DECT Overview
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Accessories

• belt clip

• carry case

• headset

• desktop charger

• data charger and data cable

Figure 16 C4050 charging rack

C4050 battery charger

• charging time maximum eight hours

• spare batteries with 24 hour charging time
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System synchronization
Clock requirements

The following clock controller cards are mandatory:

• a QPC775 Clock Controller card for a Large system

• an NTAK20BC Clock Controller Daughter-board or an NTAK79AA card 
with a built-in clock controller for a Small PBX system

If there is no digital connection to the network, the appropriate clock 
controller must be installed and operated in the free 
run mode.

On EMC-hardened Option 11 systems, the clock controller must be in one of 
the first three slots of the CPU cabinet.

Figure 17 DECT synchronization

DECT synchronization port 

Where multiple DECT systems share the same radio coverage area, the DECT 
synchronization port must be used. The DECT synchronization port is 
accessed through an MDF connection. Failure to connect the DECT 
synchronization ports of each system can lead to service interruptions.

DECT
DMC

553-8175.EPS

a
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System hardware parameters

Tables 2, 3, and 4 detail the minimum and maximum configurations for the 
DECT system with the Concentration feature. 

*One of the DMC8 positions in the CPU cabinet is required by the NTAK20 Clock 
Controller Daughterboard.

†Subject to engineering rules and constraints.

Table 2 Minimum configuration

System type
Shelves 

or 
cabinets

DMC8 DMC8-E Base 
station Handset

All systems 1 1 0 1 to 8† 1 to 510†

Table 3 Maximum Large system configuration

System type Shelves DMC8 DMC8-E Base 
station Handset

Large system 2 30 2 256† 16,320†

Table 4 Maximum Option 11 configuration

System type Cabinets DMC8 DMC8-E Base 
station Handset

Option 11E, 11C not using 
CPU cabinet

2 18 2 160† 1,0200†

Option 11 or 11E, 11C if 
CPU cabinet is used

2 17* 2 152† 9,690†

Option 11C Mini (Main cab-
inet)

1 2* 0 16† 1,020†

Option 11C Mini (Expan-
sion cabinet)

1 3 1 32† 2,040†
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The DECT system components have the following capacities:

• one NTCW00AB DMC8 or one NTCW01AB DMC8-E can support up to eight 
base stations

• one C4600 base station can support six active calls

• one C4610 base station can support 12 active calls

Multiple DECT systems can co-exist in the same PBX system if they are 
synchronized to the same clock source. However, from a user’s perspective, 
the DECT systems are separate.
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System software parameters

The software that operates the DECT system resides as firmware in the DMCs. 
The firmware consists of an operating program and a system database 
configuration. The operating program controls base station and handset 
functions. The operating program also communicates with the Meridian 1 
and the DECT Manager. The system data defines the hardware and hardware 
addressing.

The DECT system is compatible with Meridian PBX systems running X11 
Release 23 and later software.

The DMC8/DMC8-E with the ensuing software releases supports the 
following:

• Release 23 can support basic configuration, CLID and CPND, DECT card 
addressing within OA&M, and 16 users on each card.

• Release 24.2x can support up to 32 handsets per card.

• Release 25.xx can support up to 510 handsets with Concentration and 
MSMN.
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52
Site planning

This chapter contains the following topics:

Site survey . .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 40
Customer requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 40

On-site contact . .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 40
Site plans . .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 40
Building details . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 40
Position and use of available cabling . . . . . . . . . . . . . . . . . . . . . . 41
Radio coverage . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41
Number of handset users . .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42

Number of cells required to support traffic . . . . . . . . . . . . . . . . . . . . 42
Customer review . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42

Deployment . .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42
The  DECT deployment tool . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 44
The deployment process . .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45

Identifying initial critical points on the floor plan . . . . . . . . . . . . 46
Locating cell centers . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47
Determining cell boundaries . .. . . . . . . . . . . . . . . . . . . . . . . . . . . 48
Identifying additional critical points and
cell boundaries . .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49
Marking the points, centers, and boundaries on
the floor plan . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50
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Site survey

A site survey determines customer requirements, and the number of cells 
required to support traffic. After a site survey is completed, a customer 
review is required.

Customer requirements

The customer must provide the following:

• a site contact name and telephone number

• site plans

• building details

• information on available house cabling

• radio coverage requirements

• number of users

On-site contact

The on-site contact provides the following:

• time and date scheduling

• access to restricted or locked areas

• additional information when required

Site plans

A complete set of site plans are required. Dimensions must be clearly stated 
on the plans. 

Building details

System deployment and installation depends upon the following building 
details:

• building identification 

• construction materials, such as walls, floors, ceilings

• type of use, such as an office, hotel, factory, or store

• dimensions
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• number of floors

• height of floors

• partitioning of floors

Position and use of available cabling

Cables which connect the base station to the DECT System must meet or 
exceed UTP Cat 3 standard. UTP Cat 5 is recommended as it provides a 
greater line length before signal degradation occurs. New cabling is required 
if the existing cabling does not meet the standard.

Radio coverage

A base station coverage list is required to indicate the following:

• areas where radio coverage is not required

• areas excluded from radio coverage due to the proximity of sensitive 
electronic equipment

• areas where radio coverage is required

• areas where radio coverage is not feasible or requires specific base 
stations

• objects inside buildings

• details of furniture, cupboards, and machinery in the interior of 
buildings on every floor

Base station installations can be required to be out of sight. A customer 
could request base stations to be mounted in unsuitable locations, such as 
stone columns, air ducts or horizontally on the ceiling. Radio coverage 
cannot be guaranteed when base stations are mounted in unsuitable 
locations.

It must be clear in advance where coverage is required. Some examples of 
coverage areas are:

• elevators

• stairwells

• toilets

• outdoor areas 
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Number of handset users

The following information must be available:

• the number of handset users

• the potential growth of handset users

• the areas of above average and below average traffic density

Number of cells required to support traffic

Traffic requirements are determined for each cell. The deployer will calculate 
system requirements to support user traffic.

Customer review

After the site survey and before the deployment process, the person 
deploying the site must review coverage requirements with the customer 
representative. The person deploying the site must explain to the customer 
representative how the survey is conducted. The customer representative 
must tell fellow employees that a person deploying the site will be taking 
measurements in their work place.

Deployment

A deployment determines the locations of base stations and cells. The 
deployment process consists of the following activities:

• identifying initial critical points on the floor plan

• locating cell centers

• determining cell boundaries

• identifying additional critical points and cell boundaries

• marking the points, centers, and boundaries on the floor plan

Deployment terms are as follows:

• Coverage area: an area where a handset can be used to make and 
receive calls

• Cell: the coverage area provided by the base station antennas

• Cell boundary: the parameter of a cell coverage area
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• Critical point: a point or location defined as the extreme corner of a 
coverage area, that can be difficult for the radio signal to reach

• Cell center: the installation point of the base station serving the cell

• Range: the distance from a cell centre to its cell boundary

Figure 18 on page 43 illustrates these terms.

Figure 18 Example showing deployment terms
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The DECT deployment tool

The DECT deployment tool is used to locate cell centers and determine cell 
boundaries.

Figure 19 Deployment tool
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The deployment tool is stored and transported in a yellow, impact-resistant 
case. The deployment tool consists of the following components:

a. base station

b. power cord 

c. battery

d. battery mount

e. adjustable tripod 

f. extender arm connector

g. extender arm swivel and clamp

h. extender arm

i. battery charger (separately ordered)

j. battery charger cable

k. deployment handset

l. deployment handset battery charger

The deployment process

The deployment process consists of the following steps:

• Identifying initial critical points on the floor plan

• Locating cell centers

• Determining cell boundaries

• Identifying additional critical points and cell boundaries

• Marking the points, centers, and boundaries on the floor plan
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Identifying initial critical points on the floor plan

Figure 20 Critical points

A critical point is a place that can be difficult for the radio signal to reach, 
such as a corner of a room, lifts and stairwells. Initial critical points are 
shown in Figure 20 as P1, P2, P3, and P4. 

Figure 20 shows the following:

a. stairwell

b. second floor plan

553-8177.EPS

b

a

P3

P4

P1

P2

initial critical point
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Locating cell centers

Figure 21 Cell centers

A cell center is located by placing the deployment tool at one critical point, 
for example P1, then using the deployment handset to obtain a change in 
audio quality. The audio change determines the cell boundary contour. This 
process is repeated at an adjacent critical point, for example P2. Where the 
cell boundaries of both critical points meet is the cell center. The cell center 
position is marked on a floor plan. The cell center determines the location 
of a base station, shown in Figure 21 on page 47 as arc 2C1.

Figure 21 shows the following:

a. stairwell

b. second floor plan

2C1 2C2
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Determining cell boundaries

Figure 22 Cell boundaries

A cell boundary for the cell center is determined by placing the deployment 
tool at the cell center, for example 2C1, and using the deployment handset 
to establish the cell boundary. The cell boundary contour, is marked on the 
floor plan, shown in Figure 22 by a dash-dot line.

Figure 22 shows the following:

a. stairwell

b. second floor plan
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Identifying additional critical points and
cell boundaries

Figure 23 Additional critical points and cell boundaries

Additional critical points, shown in Figure 23 as P5, P6, P7, and P8, are 
identified to ensure base station radio coverage for the entire area.

Figure 23 shows the following:

a. stairwell

b. second floor plan
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Marking the points, centers, and boundaries on
the floor plan

Figure 24 Points, centers, and boundaries on the floor plan

Figure 24 shows a typical floor plan marked-up after determining subsequent 
cell boundaries. The completed floor plan would appear as follows:

• initial critical points are shown at P1 P2 P3 P4 

• cell centers are located where arcs from P1/P2, P3/P4 intersect

• 2C1 and 2C2 show the cell centers or base station locations

• dashed and dotted lines show the cell boundaries

• additional critical points are shown at P5 P6 P7 P8 

• 2C3 and 2C4 cell centers provide full coverage of the floor
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Two copies of the floor plan are needed. One copy is used during the site 
planning. The second copy is marked with the information from the site 
planning copy and is attached to the Meridian Companion Provisioning Record 
for the installer.
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58
System installation
This chapter contains the following topics:

Hardware Installation Introduction . . . . . . . . . . . . . . . . . . . . . . . . . . 53
Install Base Station . .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53
Install Additional IPE Shelves or Option 11 Cabinets . .  . . . . . . . . . 54
Install DMC8 and Faceplate Cables . . . . . . . . . . . . . . . . . . . . . . . . . 54
Install OTM DECT application . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 54
Configure the MDECT system on the OTM server . .  . . . . . . . . . . . 54
Configure handsets and retrieve subscription data . . . . . . . . . . . . . . 55
Handset subscription . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56
Base Station Power and Muting . .  . . . . . . . . . . . . . . . . . . . . . . . . . . 56
Add a V.24 serial connection . .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56
Multi-Site Mobility Networking . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57

Using the Provisioning Records, marked-up floor plans, and the site work 
order, the installation proceeds in the following order:

Hardware Installation Introduction

• Before you begin 

• Unpack and examine the equipment

Install Base Station

• DECT base station rules 

• Install C4600 and C4610 base stations 

— Install Base Station wiring to the MDF 

— Install the C4610 base station external power supply 
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• Install base station in the external housing 

• Attach the external housing to a wall 

Connect the external housing wiring to the MDF 

Install Additional IPE Shelves or Option 11 Cabinets 

• Install additional IPE modules 

• Install additional Option 11 cabinets 

— Install IPE module wiring to the MDF 

— Install Option 11 cabinet wiring to the MDF 

Install DMC8 and Faceplate Cables 

• Cross-connect base stations to the DMC8 positions 

• Cross-connect base stations to the DMC8 Relay card 

• Install DMC8 and DMC8-E in an IPE shelf (Option 51 to 81) 

• Install DMC8-E in an Option 11 cabinet 

• Install faceplate cables and inter-shelf/cabinet cable 

Install OTM DECT application 

• Ensure the DECT application is on the OTM server 

— Ensure a communications profile is associated with the DECT 
application 

— Add a communications profile for the DECT application 

— Add an Ethernet profile 

Configure the MDECT system on the OTM server 

• Install the DME on the DMC8 relay card 

• Change the DMC8 Relay card default IP address 

— Connect the DMC8 Relay card to a configuring PC 

— Reset the DMC8 Relay card default IP address to your LAN IP 
address 

• Connect the DMC8 Relay to the OTM server 

• Launch the DECT application 
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• Add your MDECT system 

— Add General System Properties 

— Set the MDECT system IP address to match the DMC8 Relay 
card 

— Add the upstream manager IP address, if required 

• Synchronize data with the MDECT system 

— Synchronize DECT PARI and SARI 

— Synchronize DECT Parameters 

— Synchronize DECT Upstream Manager IP Address 

Configure handsets and retrieve subscription data 

• Configure non-concentrated handsets on a Meridian 1 PBX 

— Open Station Administration window 

— Access Add Station dialog 

— Add 500 analog standard 

— Access features 

— Access wireless type

— Select wireless type

— Select DECT wireless set 

— Accept changes 

• Configure concentrated handsets on a Meridian 1 PBX 

— Open Station Administration window 

— Access Add Station dialog 

— Select Digital Cordless Set 

— Select Features 

— Select wireless type 

— Select Visit or local 

— Select an index 

— Provision hardware 

— Accept changes 
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— Single line features 

• Retrieve subscription data for handsets 

— Enable subscription 

— Activate the PIN on the handsets 

Handset subscription 

• C4010, C4010 Ex, C4020 handset subscription 

— Distribute C4010, C4010 Ex, C4020 handsets and install 
battery chargers 

— Subscribe the C4010, C4010 Ex, C4020 handset 

• C4050 handset subscription 

— Distribute C4050 handsets and install battery chargers 

— Subscribe the C4050 handset 

Base Station Power and Muting 

• Open RFP window 

— Set alarm muting, line power, and comments for Base 
Stations

Add a V.24 serial connection 

• DMC8 to OTM server serial connections 

• Connect the relay card to a local OTM server 

• Connect the relay card to a remote OTM server with modems 

• Install a virtual modem on your PC 

— Configure modem properties 

— Set modem speed 

— Set connection preferences 

— Disable flow control 

• Configure Remote Access Service (RAS) 

— Set RAS modem and port usage 

— Configure RAS setup and network 
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— Configure RAS services 

• Set up and configure a RAS Phone book entry 

— Open the Dial-up Networking dialog 

— Set up the phone book entry name 

— Set up the server dialog 

— Go to the next dialog 

— Set up complete 

— Configure the networking dial-up 

— Configure the Dial using entry 

— Configure the Dial-up server type 

— Configure IP address 

— Accept the configuration changes 

— Establish the RAS connection 

— Establish a connection to the DECT system 

— Establish connection complete 

— Set the IP address through Telnet 

— Configure the IP address 

— Hang-up the RAS connection 

Multi-Site Mobility Networking 

• Feature implementation 

• Feature operation 
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140
Optivity Telephony Manager for MDECT 
systems

This chapter contains the following topics:

DECT Application features . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 61
Common Services features . .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 62
OTM navigators . .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 62
OTM server connections to MDECT . .  . . . . . . . . . . . . . . . . . . . . . . 65

Access the DECT application with a 
Windows based navigator . .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68

Login to the OTM . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68
Select the Meridian 1 PBX that supports
 the MDECT system . .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69
Open DECT Application . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 70

DECT Systems window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71
What you can do with the DECT Systems window . .  . . . . . . . . . . . 72
DECT Systems window definition . . . . . . . . . . . . . . . . . . . . . . . . . . 72
Additional information about the DECT Systems window . .  . . . . . 75
System Properties dialog . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 82
Firmware upload and activation . .  . . . . . . . . . . . . . . . . . . . . . . . . . . 94

Subscriptions window . .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 97
What you can do with the Subscriptions window . . . . . . . . . . . . . . . 98
 Subscriptions window definition . . . . . . . . . . . . . . . . . . . . . . . . . . . 98
Configure and enable a subscription . . . . . . . . . . . . . . . . . . . . . . . . . 101
Disable  subscriptions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 103
Delete  subscriptions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 104
Copy subscriptions . .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 105
Move Subscriptions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 107
Import Subscriptions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 107
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Export Subscriptions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 108
Find subscriptions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 109
Synchronize DECT and Station Administration
Configuration . .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 110
Multi Site Mobility Networking subscriptions . . . . . . . . . . . . . . . . . 111
Disable Subscriptions . .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 112
Force disable . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 113

Boards (DMC) window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 117
What you can do with the Boards (DMC) window . .. . . . . . . . . . . . 117
Boards (DMC) window definition . .  . . . . . . . . . . . . . . . . . . . . . . . . 118
Board (DMC) properties sheet . .  . . . . . . . . . . . . . . . . . . . . . . . . . . . 119

Radio Fixed Part (base station) window . .  . . . . . . . . . . . . . . . . . . . . . . 122
What you can do with the Radio Fixed Part
(base station) window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 123
Radio Fixed Part (base station) window definition . . . . . . . . . . . . . . 123
Radio Fixed Part (base station) properties sheet . . . . . . . . . . . . . . . . 125

Active Alarm Snapshot window . .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 126
What you can do with the Active Alarm Snapshot
window . .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 127
Active Alarm Snapshot window definition . . . . . . . . . . . . . . . . . . . . 127
Active Alarm Snapshot properties sheet . . . . . . . . . . . . . . . . . . . . . . 128

Performance Collection window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 130
What you can do with the Performance Collection
 window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 131
Performance Collection window definition . .  . . . . . . . . . . . . . . . . . 131

Retrieve RSSI Snapshot window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 133
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Alarm browser . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 137
Web Access security . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 138

The Optivity Telephony Manager (OTM) provides a single point of access and 
control for managing various Meridian 1 applications.

OTM provides a DECT Application and OTM Common Services to manage an 
MDECT system. OTM runs on Windows NT 4.0, Windows 98, Windows 2000 as 
a server plus Windows 95 as client.

DECT Application features
The DECT Application provides the following MDECT managing features. The 
DECT Application allows you to do the following:

• launch the Application from OTM using Windows and Web navigators

• view the MDECT System provisioning with the DECT Systems window

• view the DMC8 configuration with the Boards window

• view base station configuration with the Radio Fixed Part window

• view subscription information with the Subscriptions window

• upgrade Firmware using the DECT Systems window

• subscribe handsets using the Subscription window

• support DMC-8 and DMC (serial only)

• synchronize (update) the DECT Application database to the MDECT 
system configuration when the OTM connects to the MDECT system

• collect performance data using the Performance Collection window

• view On-line Help

NOTE
For an overview of OTM, see Using Optivity Telephony Manager for 
Meridian 1 (553-3001-330).
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Common Services features
The following DECT management features are provided by the OTM Common 
Services:

• OTM Alarm Management provides alarm collection and alarm processing, 
and gives the following:

— Web based alarm browser used to view alarms, past alarms 
and occurring alarms

— Windows based alarm browser used to view only those 
alarms that occur while the browser is open

— Alarm Notification application can notify you of an alarm 
occurrence by pager, E-mail, and can forward the alarm to 
an upstream processor

— PC Event log and Viewer used to view events and alarms 
generated from the DECT Application in a report layout.

• Backup and restore lets you create an OTM backup file of the DECT 
application data.

• User profiles allows you to configure different types of DECT users.

• On-line help, provides help for common services features.

For more information about the Common Services features, see Using Optivity 
Telephony Manager for Meridian 1 (553-3001-330).

OTM navigators
There are two navigators used with the DECT application to manage an 
MDECT system:

• a Windows® based navigator

• a Web based navigator

A Windows based navigator, that uses the Microsoft Windows interface, can 
access all DECT application features. A Web based navigator, that uses the 
Web (http) interface, can access most, but not all, DECT application 
features.

Use the Windows based navigator if you are managing an MDECT system, at 
the keyboard and mouse of an OTM server. (Figure 25 and Figure 26)
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You must use a Web based navigator if you are managing an MDECT system 
from a client PC. (Figure 25 and Figure 26)

Features available to Windows based navigators
The following features are only available at an OTM server using the Windows 
based navigator. The OTM server can:

• define MDECT  sys tem si te s

• define PBX system

• conf igure handsets  w ith  the Sta t ion Adminis t rat ion 
feature  of OTM

• OTM A la rm Not i f i ca t ion

• PC Event log and Viewer

• backup and re store  the MDECT Manager database  to  and 
from  a  f i le

• define a user profile for Windows based applications

• define user management for Windows based applications

Features available to both Windows and Web based navigators
Provisioning features
The following provisioning features are available using either a Windows 
based navigator or a Web based navigator:

• define MDECT system

• MDECT system names

• MDECT Concentration mode

• MDECT system Access Right

• Transmission parameters

• DMC8 provisioning

• Firmware provisioning

• Base Station provisioning
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Operation features
The following operation features are available using either a Windows based 
navigator or a Web based navigator:

• MDECT system connectivity

• MDECT system connection control

• Read data from a MDECT system on demand

• Define handsets with the overlays in the OTM database

• Define handsets in the MDECT database

• Subscribe handsets

Maintenance features
The following maintenance features are available using either a Windows 
based navigator or a Web based navigator:

• Operational status monitoring

• Alarm management

• Date and Time

• Upstream Manager IP address

• Basic browser

• MDECT system data synchronization with the MDECT Manager database

• Performance

• PC Event Log

Security features

For information about the Security features, see Using Optivity Telephony 
Manager for Meridian 1 (553-3001-330).
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OTM server connections to MDECT 

Figure 25 shows an overview of an OTM server connected to an MDECT system 
over a V.24 interface. Web clients access the OTM server over a LAN or WAN 
and over the Public Switched Telephone Network, using modems. For the 
OTM to communicate over PPP with the MDECT system, configure Remote 
Access Service (RAS) for modem dial out. See Access the DECT application 
with a Web based navigator, page 134. For more information about OTM 
access, see Using Optivity Telephony Manager for Meridian 1 (553-3001-330).

A client, in this specific case, is a DECT application that runs on a personal 
computer or workstation and depends on an OTM server to perform some 
operations. For example, a DECT application client is an application that 
enables you to manage an MDECT system.

Figure 26 shows an overview of an OTM server connected to an MDECT 
system, over a dedicated LAN interface.

Remote Access Service (RAS)
A computer in a network that provides access to remote users via analog 
modem or ISDN connections. It includes the dial-up protocols and access 
control (authentication) and can be a regular file server with remote access 
software or a proprietary system. The modems can be internal or external to 
the device.

ISDN - An international telecommunications standard for providing a digital 
service from the customer's premises to the dial-up telephone network.
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Figure 25
Local OTM server access to an MDECT system by V.24
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Figure 26
Local OTM server access to an MDECT system by dedicated LAN
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Access the DECT application with a 
Windows based navigator

For access from a Web based navigator, see “Access the DECT application 
with a Web based navigator” on page 134.

Login to the OTM

Figure 27
OTM login dialog box

You access the OTM Login dialog box using the Start menu, under 
Programs, OTM. The login dialog appears as shown in Figure 27. On entering 
your User ID and Password, the OTM Windows Navigator window appears, as 
shown in Figure 28.

NOTE

See Using Optivity Telephony Manager for Meridian 1 (553-3001-330) for 
details about the OTM login dialog box.
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Select the Meridian 1 PBX that supports
 the MDECT system

Figure 28
OTM Navigator window

In the OTM Navigator window, select the Meridian 1 system that supports 
the MDECT system you want to administer. Double-click on the Meridian 1 
system (shown as Sample Site in Figure 28), and the M1 System Window 
(example shown in Figure 29) appears.

NOTE

See Using Optivity Telephony Manager for Meridian 1 (553-3001-330) for 
details about the OTM Navigator window.
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Open DECT Application

Figure 29
M 1 System Window

Open the DECT application by double clicking on DECT (shown in Figure 29), 
or open through the File menu. This action displays the DECT System window 
(shown in Figure 30).
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DECT Systems window

Figure 30
DECT Systems window

List filter

List

Connection status

Operation progress
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What you can do with the DECT Systems window
This window allows you to:

• select an MDECT system to view database details or select all MDECT 
systems to view database details

• add an MDECT system

• delete an MDECT system

• connect to, disconnect from, lock or unlock a connection between your 
OTM server and an MDECT system (See “Connecting to an MDECT system” 
on page 75.)

• open the following windows for selected MDECT systems

— Subscriptions

— DMC Boards

— Base station Radio Fixed Parts

— Active Alarm Snapshot

— Performance Collection

— Current RSSI data

DECT Systems window definition
The DECT Systems window displays the following:

• File, holds a pull-down menu that allows you to select one of the 
following:

— Add, creates a new MDECT system with default values and 
opens the DECT System Properties window

— Delete, removes an MDECT system from the OTM server/OTM 
client

— Connect / Lock / Disconnect, same functions as the 
Connect/Disconnect tool (See “Connecting to an MDECT system” 
on page 75.)

— Properties, opens the DECT System Properties window (Figure 
38 to Figure 49)

— Close, closes the client application and all DECT windows 
opened by that client
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• View, holds a pull-down menu that allows you to show or hide the:

— Tool bar

— Status bar

• Applications, holds a pull-down menu that allows you to open the 
following windows:

— Subscriptions (Figure 55)

— Boards (DMC) (Figure 69)

— Radios (base stations) (Figure 71)

— Current Alarms 

— Performance Collection (Figure 75)

— Current RSSI data (Figure 77)

• Firmware, holds a pull-down menu allowing you to open the following 
windows:

— Upload, loads firmware to DMC (Figure 50)

— Activation, makes a firmware active 

• Help, holds a pull-down menu that allows you to select:

— Content and Index

— About OTM DECT Management application

• Tool bar icon, that allows you to click the tool button to:

—  open a connection to an MDECT system selected in the 
List when the Connection status shows Disconnected. When 
opened the icon changes to red. See “Connecting to an MDECT 
system” on page 75.

—  lock the connection to an MDECT system when the 
Connection status is Connected. This prevents another user 
from closing the connection.
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—  disconnect from an MDECT system when the Connection 
status is Connected

—  unlock the connection from an MDECT system when the 
Connection status is Connected Locked

• List filter, allows you to select one of the following:

— This Meridian only, lists the MDECT System data you select 
from the M1 System Window (Figure 29)

— All DECT Systems, lists every MDECT Systems data managed 
by the OTM server

• List field, shows the following for the MDECT system or systems 
selected from the M 1 System Window (Figure 29):

— site name/location (Figure 38)

— Meridian 1 PBX name (Figure 38)

— MDECT system name (Figure 38)

— presence of an alarm (Figure 48)

— IP address, for the MDECT system (Figure 44)

— Primary Access Rights Identifier (Figure 46)

— Concentration mode (Figure 38)

— number of subscribed handsets (Figure 38)

— connection status

• Connection status field, shows the current state of the connection, 
where;

— Disconnected indicates no communication between the OTM 
server and an MDECT system.

NOTE

While the Connection status is Connecting or Disconnecting the 
Connect/Disconnect tool is disabled. The status bar shows the 
connection progress.
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— Connected indicates communication between the OTM server 
and an MDECT system for an operation initiated by a user. 
The connection disconnects when the operation is finished.

• Operation progress field, shows the last received event associated 
with the connection, such as:

— Disconnecting

— Connecting

— Modem Busy

— Dialing

Additional information about the DECT Systems window
Connecting to an MDECT system

When you open the first connection to a new, installed MDECT system, the 
OTM DECT Application retrieves the DMC configuration from the OTM 
database. The OTM DECT Application reads the parameters from the MDECT 
system for the manager database.

You can do one of the following to open a connection to an MDECT system 
from an OTM DECT Application:

• check the Permanent Connection box, (Figure 42) allowing the 
connection to open when the OTM server starts

• select an MDECT system in the list and click the Connect icon

• select an action on the menu bar that requires a system connection. For 
example, Firmware > Upload; the connection opens to carry out the 
upload and then closes. 

The status bar of the application provides progress feedback while the 
connection is opening.

NOTE

Avoid using this type of connection opening for subscription actions 
otherwise the subscription status is not refreshed when an on-air 
subscription or de-subscription occurs.
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Synchronization when the DECT Application connects to an 
MDECT system

When your DECT manager connects to the MDECT system, synchronization 
occurs. Synchronization compares the database on your manager to that of 
the MDECT system. Database mismatches are flagged by dialogs. You then 
have the opportunity to change either the MDECT system data or the 
manager data.

A number of synchronization steps occur during connection. 
Synchronization flags changes made to an MDECT system database by other 
managers.

Two types of synchronization occur when the connection state goes from 
Disconnected to Connected, as follows:

• when you use the File menu or tool button to connect. You can control 
the synchronization through dialogs.

• when the OTM re-establishes a permanent connection to the MDECT 
system. A synchronization report is available in the Event log on the 
OTM server.

When you connect to an MDECT system that has data that does not match 
the OTM DECT Application data, choose one of the following:

• update the OTM DECT Application database from the MDECT system data

• update the MDECT system data with the OTM DECT Application database

The following dialogs show the type of validation done at connection time.
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Figure 31
Synchronize DECT PARI and SARI Mismatch dialog

If there is a PARI or SARI mismatch between your OTM DECT Application 
database, and the database of the MDECT system, the mismatch dialog 
allows you to update the PARI and SARI parameters on the:

• connected MDECT system

• your OTM DECT Application
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Figure 32
Synchronize DECT Parameters Mismatch dialog

If there is a Parameter mismatch between your OTM DECT Application 
database, and the database of the MDECT system, the mismatch dialog 
allows you to update the Parameters on the:

• connected MDECT system

• your OTM DECT Application
553-3601-103 Standard 4.00 June 2001



 Optivity Telephony Manager for MDECT systems Page 79 of 158
Figure 33
Synchronize DECT Board Configuration Mismatch dialog
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The dialog shows DMC TNs (Boards) listed in your OTM DECT Application 
database that are not in operation on the MDECT system. Delete the check 
in the check boxes allows you to remove DMCs no longer required in your 
OTM DECT Application database.

Figure 34
Synchronize DECT Radio Fixed Part Configuration Mismatch dialog
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The dialog shows Radio Fixed Parts (Base stations) listed in your OTM DECT 
Application database that are not in operation on the MDECT system. Delete 
the check in the check boxes allows you to remove the base stations no 
longer required in your OTM DECT Application database.

Figure 35
Synchronize Radio Fixed Part Settings Mismatch dialog

A Power Source/Alarm Muting setting was changed by another manager. This 
dialog tells you that the OTM DECT Application database automatically 
updates to match the changed settings.

Figure 36
Synchronize DECT Upstream Manager IP Address Mismatch dialog
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If there is an Upstream Manager IP address mismatch, between your OTM 
DECT Application database and the database of the MDECT system, the 
mismatch dialog allows you to update the Upstream Manager IP address on 
the:

• connected MDECT system

• your OTM DECT Application

Figure 37
DECT Subscription Configuration Mismatch dialog

The dialog warns you of a DMC mismatch between the MDECT system and the 
OTM server database. The manager cannot automatically solve the 
mismatch. You have to solve the mismatch manually.

 

System Properties dialog
DECT System Properties dialog - General tab

The DECT System Properties dialog is selected from the File menu.
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Figure 38
DECT System Properties - General tab

The General tab allows you to do the following:

• view the site name

• view the Meridian 1 PBX name

• view or change the DECT System name (Figure 39 and Figure 40)

• change the password (Figure 41)

• view if Concentration mode is active or Concentration mode is not 
active

• view the number of subscribed handsets

DECT System Name Missing dialog appears when a DECT System name is 
not entered.
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Figure 39
DECT System Name Missing dialog

The application will not allow a system to be saved unless a name has been 
provided and is unique.

The DECT System Name Already in Use dialog appears when a DECT System 
name is the same as the name of another system.

Figure 40
DECT System Name Already in Use dialog
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The Change DECT System Password dialog is selected from the DECT System 
Properties dialog, General tab.

Figure 41
Change password dialog

If the new password does not match the confirmed password, a dialog warns 
you that the passwords do not match and allows you to change the 
passwords.
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DECT System Properties dialog - Communication tab

The DECT System Properties dialog is selected from the File menu.

Figure 42
DECT System Properties - Communication tab

The Communication tab allows you to do the following:

• view or change the unique IP address, used if the connection is Serial 
or Ethernet

• view the Subnetwork Mask

• view the Gateway IP address
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• check a Permanent Connection, to;

— keep the connection open

— open the connection when the OTM starts

• select Close Connection (Figure 43)

• select Ethernet or Serial connection

• select Details for the Serial connection (Figure 44)

• save a new MDECT system definition by pressing the OK button. This 
causes the manager to try to connect to a new MDECT system and write 
the system name in MIB2, after you:

— enter the new system IP address

— specify the new system name

The Close Connection dialog is selected from the DECT System Properties 
dialog, Communication tab.

Figure 43
Close Connection dialog
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System Deta iled Connect ion sett ings properties  is selected 
from the Details button of DECT System Properties dialog Communication 
tab.

Figure 44
DECT System Detailed Connection settings properties

The System Deta i led  Connect ion  set t ings propert ies  allows you to 
do the following:

• view or change the OTM Server IP interface assigned to the PC RAS port 
interface on the same network as the DECT system
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• view or select the COM Port attached to either the DECT system or the 
modem

• select a modem mode

• view or change the Phone Number that dials the modem 

Figure 45
Local and remote IP address for serial connections

You supply an IP address for local and remote ends of the serial link, so the 
OTM can route IP traffic to the correct MDECT system.

DECT System Properties dialog - Access Right Identification tab

The DECT System Properties dialog is selected from the File menu.

MDECT System 1

MDECT System n

OTM Server

Serial links

IP at MDECT System 1 remote

IP at MDECT System n remote

IP at MDECT System n local

IP at MDECT System 1 local
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Figure 46
DECT System Properties - Access Right Identification tab

There are two Access Right Identification, a Primary and a Secondary, which 
identify each MDECT system. The Access  Right  Ident i f ica t ion  allows you 
to do the following:

• view or change the PARI (Figure 47)

• view or change the SARI (A SARI dialog box is similar to that shown in 
Figure 47)

Change PARI dialog appears when you press the Change PARI... button of 
the Access  Righ t Ident i f ica t ion .
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Figure 47
Change PARI dialog

You must not change the PARI or SARI until you connect to the MDECT 
system requiring the new PARI or SARI.

During synchronization, a dialog warns you if a MDECT system has a different 
PARI or SARI than the OTM DECT manager. 

See “Multi Site Mobility Networking subscriptions” on page 111 for 
additional information about changing the PARI and SARI.
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DECT System Properties dialog - Alarm tab

The DECT System Properties dialog is selected from the File menu.

Figure 48
DECT System Properties - Alarm tab

The Alarm  allows you to do the following:

• view a Yes or NO in the active alarm when the manager is connected to 
an MDECT system with an active alarm

• view or change the Upstream Manager IP address. The MDECT system 
can send alarms to an upstream manager.

• view or change the Date and Time, used to timestamp alarms. When not 
connected, the Date and Time fields are blank. When the MDECT system 
is reset, the time and date are not updated.
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DECT System Properties dialog - Parameters tab

The DECT System Properties dialog is selected from the File menu.

Figure 49
DECT System Properties - Parameters tab

The Parameters allows you to do the following:

• view or change Tone Duration in milliseconds

• view or change Inter Digit Pulse width in milliseconds

• view or change Level 1 - low frequency in decibels

• view or change  Level 2 - low frequency in decibels
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• view or change Analog/Digital loss pad- handset to system in decibels

• view or change Analog/Digital loss pad- system to handset in decibels

• set all parameters to Factory Default values

Do not use the Advanced... button as it can cause your system to fail.

The DECT System Properties Parameters are read from the MDECT system on 
synchronization. 

Firmware upload and activation

The Firmware upload dialog is selected from the Firmware menu.

Figure 50
Firmware upload with DMC-4 dialog

The designator DMC is used to differentiate between the NTCW00AA DMC and 
the NTCW00AB DMC8. 

This dialog alerts you that a DMC cannot support a firmware upload. If you 
select OK, a file chooser lets you select a firmware file (Figure 52), from the 
Client or from the OTM server. When ok is selected, you can replace the 
existing standby firmware with new firmware.

You can do one of the following:

• accept the firmware for the MDECT system

• cancel the firmware upload for the MDECT system
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Figure 51
Firmware upload dialog

Figure 52
Firmware activation dialog
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Figure 53
Upload file chooser

The Upload f i le  chooser  radio buttons allow you to:

• browse files on the Client PC 

• browse files on the OTM Server

You can select a file from either the client or the server to upload to the 
MDECT system.

Figure 54
Progress indicator
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Subscriptions window

The Subscriptions window is selected from the DECT Systems window 
Applications menu.

Figure 55
Subscriptions window
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What you can do with the Subscriptions window
This window allows you to:

• connect to, disconnect from, lock or unlock a connection between your 
OTM server and an MDECT system

• choose to show, in any combination, (Figure 57 and Figure 58) handsets 
that are:

— Available

— Subscribed

— Enabled

— Blacklisted

— configured on one DMC8 or all DMC8s

• Subscribe (configure) handsets

• De-subscribe handsets

• Copy subscription data

• Move subscription data

• Delete subscription data

• Find subscription data

• Export subscription data

• Import subscription data

 Subscriptions window definition
The Subscriptions window displays the following:

• File, holds a pull-down menu allowing you to select one of the 
following:

— Import, a subscription from a file (Figure 61)

— Export, a subscription to a file (Figure 62)

NOTE

Before a handset will work, the handset must be programmed on the 
Meridian 1 PBX using LD 10.
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— Connect, Lock, Unlock, Disconnect

— Properties, includes data in the subscription list and 
International Portable User Identifier (IPUI) (Figure 68)

— Close, the Subscriptions window

• View, holds a pull-down menu allowing you to show or hide the:

— Tool bar

— Status bar

• Edit, holds a pull-down menu allowing you to open the following dialog 
boxes:

— Copy (Figure 59)

— Delete (Figure 58)

— Find (Figure 63)

• Operations, holds a pull-down menu allowing you to open the following 
windows:

— Configure, allows you to program a handset on the 
Meridian 1 system (Figure 56)

— Set Default PARK, allows you to enter the default Portable 
Access Rights Key (Figure 65)

— Enable, allows you to subscribe a handset

— Disable, allows you to de-subscribe a handset from one 
MDECT system (Figure 66) or de-subscribe a handset from all 
MDECT systems (for example, Multi Site Mobility 
Networking, (page 111) 

— Force Disable, allows you to return the subscription to the 
available state, requests the system to disable the 
subscription. However, there is no interaction between the 
system and handset. (Figure 67)

— Retrieve OTM Configuration, allows you to retrieve the 
Meridian 1 handset configuration from the OTM Station 
Administration database. If there is a mismatch between 
the Station Administration configuration and the DECT 
application configuration, (Figure 64)

• Help, holds a pull-down menu allowing you to select:
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— Content and Index

— About DECT application

• Tool bar, allows you to click the tool button to:

—  connect,  lock,  unlock,  disconnect, same 
function as DECT Systems window (page 71)

—  enable, allows you to subscribe a handset

—  disable, allows you to de-subscribe a handset 

—  configure, allows you to program a handset

• List filter, allows you to show or hide details of handsets that are:

— available (Figure 57 and Figure 58)

— subscribed (Figure 57 and Figure 58)

— enabled (Figure 57 and Figure 58)

— black-listed (Figure 57 and Figure 58)

— DMC restricts the list to subscription data for one DMC or 
lists subscription data for all DMC 

• List, shows the following subscription details for handsets assigned to 
a <sitename>, a <PBX name>, a <DECT system name>: (Figure 55 title 
bar)

— DMC TN

— index, 32 units or 510 virtual units for concentration on a 
DMC

— concentrated handset Home DN

— concentrated handset Local DN, different than Home DN for 
visitor concentrated handset

— virtual TN for concentration handsets

— subscription PARK

— subscription status, updated by SNMP traps from the MDECT 
system
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— PIN code shown during subscription activation

— an 80-character comment

• Pop up menu, available when at least one subscription is selected, 
contains the following items:

— Configure

— Enable

— Disable

— Copy

— Move

— Delete

— Export

— Properties

— Help

• Status bar, shows:

— connection status

— operation status

— current subscription PARK

Configure and enable a subscription

Figure 56
Configure DECT Subscription dialog
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Configure DECT Subscription allows you to:

• select a DMC TN

• enter the first subscription index (unit, as in l s c u)

• select a number of consecutive subscriptions

When configured, the subscription becomes available and you can enable 
the subscription. During the enable process, the DECT manager generates a 
PIN code for the subscription. (Figure 57).

Figure 57
Enable a subscription

Available

Enabled

Subscribed

PIN
code

entered within
15 minutes

?

No

Yes

DECT channel is configured
and available for subscription.

The subscription process starts with the user selecting
the handset(s) and pulling down the Operations menu
then clicking on Enable

The handset is now ready to make and receive calls

The OTM DECT manager provides a PIN
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Disable subscriptions
You can de-subscribe a subscription on:

• a single handset 

• a list of selected handsets

• all handsets on a DMC

Figure 58
Disable a subscription

Launching an on-air de-subscription requires an open connection to the 
MDECT system.

When the DECT Manager starts the de-subscription, the MDECT system holds 
the de-subscription until one of the following occurs:

• the handset makes or receives a call

• the DECT Manager removes the subscription

Available

Black listed

Subscribed

The de-subscription process starts with the user selecting
the handset(s) and pulling down the Operations menu
then clicking on Disable

The handset can make and receive calls

The following conditions must exist:
- connection with the system
- handset in range
- handset on
- handset go off-hook or called 

Handset ready for subscription
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The MDECT system notifies the DECT Manager that the handset is 
de-subscribed.

The DECT manager can stop a handset from operating on all the MDECT 
systems where the handset is subscribed with a given International Portable 
User Identifier (IPUI).

To stop a handset from operating, requires that the handset is within radio 
range and ready for on-air de-subscription. The process removes handset 
subscription data from the following:

• the MDECT system DMCs

• the handset

• the DECT managers handset and MDECT system files

When the handset’s subscription data is removed, the handset no longer 
works on any MDECT system.

Delete subscriptions
The Delete operation allows you to remove handset information from the 
manager and the MDECT system, but not the handset. The Delete operation 
does not require the handset to be available for on-air de-subscription. The 
Delete operation does the following:

• removes the MDECT system handset subscription data

• retains the handsets subscription data, if the handset had subscription 
data (As the handset does not remove its subscription data, it 
continues operating on all the MDECT systems where this subscription 
is relevant.)

• removes the DECT manager handsets subscription data including 
comments and Meridian 1 PBX Station Administration data

The DECT Manager provides the ability to remove subscription records from 
the following:

• a single handset subscription

• a list of selected subscriptions

• a DMC or from all DMCs at once

The subscription removal requires an open connection to the MDECT system.
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You can remove subscription records to:

• clean a Multi Site Mobility Networking MDECT system subscriptions on 
the distributors premises

• move a DMC from one MDECT system to another

Copy subscriptions

The Copy Subscription dialog is selected from the Edit menu.

Figure 59
DECT Copy Subscription dialog

The copy dialog allows you to copy subscriptions from a DMC on MDECT 
system A and paste the subscriptions into a DMC on MDECT system B. The 
subscriptions have to be in the Subscribed status.

You select the Destination MDECT system and the Destination DMC from the 
DECT Copy Subscription dialog. The connection to the destination system 
must be open.

You can copy subscriptions from the following:

• a single handset subscription
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• a list of selected subscriptions

• a DMC

In Figure 59 the source subscription data is in the three left columns; DMC 
TN, Index, and Local DN. You view the source subscription from the 
Subscription window. The destination subscription data is in columns To: 
DMC TN, and To: Index. Index is the Unit on the DMC. When the dialog 
opens, the source DMCs and destination DMCs are the same.

When you copy, you must connect to the destination MDECT system.

The Copy Subscription feature provides a way to support Multi Site Mobility 
Networking, by allowing you to subscribe handsets without being on the 
Distributor Premises.

Figure 60
Replace DECT Subscription dialog

NOTE

You cannot copy subscriptions within the same MDECT system. When a 
subscription is copied, only the MDECT system data is copied, not the 
Meridian 1 PBX data.
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The Replace dialog allows you to confirm an action whose scope is more than 
the one object that you want to overwrite at the destination.  (Figure 60).

Move Subscriptions

The Move Subscriptions dialog is selected from the Edit menu.

Move Subscriptions is similar to Copy, except for the following. The move 
dialog allows you to cut/remove subscriptions from a DMC on MDECT system 
A, and paste the subscriptions into a DMC on the same MDECT system, or 
MDECT system B. 

When you move, you must connect to both the source MDECT system and the 
destination MDECT system.

Import Subscriptions

The Import Subscriptions dialog is selected from the File menu.

Figure 61
Import Subscription dialog
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Import Subscriptions is similar to Copy, except for the following. The import 
dialog allows you to copy subscriptions from an import file and paste the 
subscriptions into a DMC on an MDECT system. 

To paste a subscription, you must be connected to an MDECT system.

Export Subscriptions

The Export Subscriptions dialog is selected from the File menu.

Figure 62
Export Subscription dialog

Export Subscriptions is similar to Copy, except for the following. The export 
dialog allows you to copy subscriptions from an MDECT system and paste the 
subscriptions into a file. (Figure 62).

NOTE

Import/Export are used to support Multi Site Mobility Networking and 
Subscription on the Distributor Premises to a MDECT system normally 
managed by OTM “B”, not your OTM “A”.
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Find subscriptions

The Find Subscriptions dialog is selected from the Edit menu.

Figure 63
Find Subscription dialog

The Find operation allows you to find subscription information by searching 
for an IPUI or a Home DN, using the Find DECT Subscription dialog. (Figure 
63)

The find action displays the subscription information in the Find DECT 
Subscription Result dialog.
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Synchronize DECT and Station Administration
Configuration

The Synchronize DECT and Station Administration Configuration dialog is 
selected from the Operations menu (Retrieve OTM Configuration) if there is 
a mismatch. If there is no mismatch synchronize occurs and Figure 64 does 
not appear.

Figure 64
Synchronize DECT and Station Administration Configuration Mismatch

MDECT systems have configured and subscribed handsets as TNs. The 
Meridian 1 PBXs have matching TN handsets configured in LD 10.

Meridian PBX to MDECT system synchronization
If the Meridian PBX configuration data is available through the OTM Station 
Administration database, then a synchronization facility is available to 
import the data into the DECT manager. Synchronization follows the 
following rules:

• A handset not listed in the DECT Manager but present in the OTM 
database is added in the DECT Manager list.

• If the DECT Manager lists a handset but the OTM database does not, the 
DECT Manager prompts you to either keep or remove the handset.

You can add handsets to the DECT manager by selecting Configure from the 
Operations menu. (page 110)
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The Synchronize DECT and Station Administration Mismatch dialog 
highlights DMC TNs in the DECT manager that are not configured in the OTM 
Station Administration. You can check those subscriptions that you must 
keep in the DECT manager. (Figure 64)

If there is no mismatch that OTM cannot resolve automatically, the 
Synchronize DECT and Station Administration dialog does not appear. For 
example, there are no entries in the Station Administration database, or the 
DECT Manager does not have a DMC configured in a Meridian 1 PBX TN 
location, where an entry does exist in the Station Administration database.

Multi Site Mobility Networking subscriptions

In Multi Site Mobility Networking (MSMN), a handset is subscribed in a given 
MDECT system and used in one or many MDECT systems. 

Every handset has a Portable Access Rights Key (PARK). Every MDECT system 
has a Primary Access Rights Identifier (PARI), and can have a Secondary 
Access Rights Identifier (SARI).

The handset PARK and MDECT system PARI and SARI are used by the handset 
and MDECT system to identify each other. The PARK and PARI/SARI match 
allow the handset to work with an MDECT system.

In an MSMN network, for example, MDECT system “A” has a PARI matching 
a handset PARK and MDECT systems “B”, “C”, and “D” have a SARI matching 
the handset PARK.

The DECT Manager user programs the SARI in the MDECT system. The DECT 
Manager provides the PARK during the on-air subscription, and the PARK is 
programed into the handset at subscription time. (Figure 46 and Figure 47)

For example, you can subscribe a handset on an MDECT system on a 
distributors premises, where the handset is not to be in operation. You then 
download the subscription data to an MDECT system where the handset is to 
be in operation. The PARI of the MDECT system where the handset is 
subscribed and the SARI of the MDECT system where you use the handset are 
not always the same. You provide the PARK matching the destination MDECT 
system to the handset during the on-air subscription.
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Figure 65
DECT Default Subscription PARK dialog

The DECT Manager provides the ability to specify the PARK given to the 
handset, to support Multi Site Mobility Networking and Subscription on the 
distributor premises (Figure 47). The PARK normally defaults to the PARI of 
the system where the on-air subscription occurs. For MSMN, you must set 
the default PARK equal to the network SARI value before any subscription 
activity.

The PARK used by the OTM DECT subscription application is subject to the 
following:

• PARK is limited to the lifetime of the subscription application

• two different users can use a different PARK on the same MDECT system 
at the same time

• PARK is not recorded in persistent storage

Disable Subscriptions

The Disable Subscriptions dialog is selected from the Operations menu.
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Figure 66
Disable DECT Subscription dialog

You can disable a handset from all MDECT systems used in Multi Site Mobility 
Networking systems. (Figure 66)

Use from this system only or if you know the handset is on-air on this 
MDECT system. This MDECT system contacts the handset. When contact is 
established the subscription is removed from the handset. The subscription 
is removed from the system database, and the OTM server database. The 
other MDECT systems remove subscription data in the background, and the 
OTM server updates its database for these systems.

Use from all systems where the portable set is subscribed, asks all MDECT 
systems to contact the handset. The first MDECT system to contact the 
handset removes the handsets subscription. The subscription is removed 
from the first MDECT system database, and the OTM server database. The 
other MDECT systems remove subscription data in the background and the 
OTM server updates its database for these systems.

Force disable

The Force disable DECT Subscriptions dialog is selected from the Operations 
menu.
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Figure 67
Force disable DECT Subscription dialog

Force Disable returns the subscription to the available state, requests the 
system to disable the subscription. However, there is no interaction 
between the system and handset.

You can use Force Disable when the handset is not in range or on-air.

Use on this DECT System only or if you want to remove the handset 
subscription from only this MDECT system and remove the handset 
subscription from all other MDECT systems in the background.

Use on all DECT Systems where it is present? if you want to remove the 
handset subscription from all systems at the same time.
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Subscription properties

The Subscription properties sheet is selected from the File menu.

Figure 68
Subscription Properties

What you can do with the Subscription properties sheet
This properties sheet allows you to:

• view the DMC Terminal Number

• view the Index. Index is the TN unit, as programmed in LD 10 in a 
non-concentrated system, and a virtual TN unit in a concentrated 
system.

• change and apply Comments, up to 80 characters

• view Home Directory Number (where the handset is configured on the 
Meridian PBX as the home location)
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• view Local Directory Number

• view Home handset only

• view handset Virtual Terminal Number

• view the International Portable User Identifier (IPUI)

• view the subscription PARK

• view the subscription status

• view the subscription PIN

Subscription properties sheet definition
The Subscription properties sheet displays the same subscription data as the 
Subscriptions window list items.  
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Boards (DMC) window

The Boards window is selected from the DECT Systems window Applications 
menu:

Figure 69
DMC window

What you can do with the Boards (DMC) window
This window allows you to:

• examine DMC details
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• connect to, disconnect from, lock or unlock a connection between your 
OTM manager and an MDECT system

• choose to show operational DMC, or Non-operational DMC or both

• open a properties sheet

Boards (DMC) window definition
The Boards window displays the following DMC data: 

• File, holds a pull-down menu allowing you to select one of the 
following:

— Clear, erases all subscriptions, sets all base stations to 
installed status and line powered, allowing you to program 
the DMC in a new MDECT system

— Connect, Lock, Unlock, Disconnect,  works the same as the 
Connect/Disconnect tool

— Properties, (Figure 70)

— Close, closes the DMC window

• View, holds a pull-down menu allowing you to show or hide the:

— Tool bar

— Status bar

• Synchronization, holds a pull-down menu allowing you to:

— Synchronize From, subscription and base station alarm 
muting/power source configuration data from a DMC to the 
OTM server 

— Synchronize To, subscription and base station alarm 
muting/power source configuration data from the OTM 
server to a DMC

• Help, holds a pull-down menu allowing you to select:

— Content and Index

— About DECT application

• Tool bar, allows you to click the tool button to:

—  connect,  lock,  unlock,  disconnect
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• List filter, allows you to show list details of only the operational DMC 
or non- operational DMC or both

• List, shows the following DMC details:

— DMC TN

— DMC type

— relay DMC

— operational state, when DMC operational status changes, 
the OTM server updates the status

— Number of handsets on a DMC

— an 80-character comment

• Pop up menu, 

— Synchronize from DMC

— Synchronize to DMC

— Properties

— Help

• Properties, displays additional information about DMC. Only the 
comment can be modified. (Figure 70)

Board (DMC) properties sheet

The Board properties sheet is selected from the File menu.
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Figure 70
Board (DMC) properties sheet

What you can do with the Board properties sheet
This properties sheet allows you to:

• view DMC details

• view operational status. When the DMC operational status changes on 
the MDECT system, the OTM updates the status.

• change and apply Comments, up to 80 characters

• view DMC Type Number

• view DMC Manufacture Code

• view DMC Standby Software Package

• view DMC Boot Package

• view DMC Protocol Version
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• open the help file

• close the properties sheet
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Radio Fixed Part (base station) window 

The Radio Fixed Part window is selected from the DECT Systems window 
Applications menu:

Figure 71
Base station window
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What you can do with the Radio Fixed Part
(base station) window

This window allows you to:

• examine base station details

• connect to, disconnect from, lock or unlock a connection between your 
OTM server and an MDECT system

• choose to show Muted base stations, or Not Muted base stations or both

• cancel mute  allows a base station to generate alarm messages or 
mute  keeps a base station from generating alarm messages

• open a properties sheet

Radio Fixed Part (base station) window definition
The Radio Fixed Part window displays the following base station data: 

• File, holds a pull-down menu allowing you to select one of the 
following:

— Connect / Lock / Unlock / Disconnect, works the same as the 
Connect/Disconnect tool

— Properties, opens the Radio Fixed Part properties sheet

— Close, closes the Radio Fixed Part window

• View, holds a pull-down menu allowing you to show or hide the:

— Tool bar

— Status bar

• Edit, holds a pull-down menu allowing you to:

— Mute Alarms, keeps a selected base station from generating 
alarms

— Cancel Mute Alarms, allows a selected base station to 
generate alarms
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• Help, holds a pull-down menu allowing you to select:

— Content and Index

— About DECT application

• Tool bar icon, allows you to click the tool button to:

—  connect,  lock,  unlock,  disconnect

—  Mute Alarms, keeps a selected base station from 
generating alarms

—  Cancel Mute Alarms, allows a selected base station to 
generate alarms

• List filter, allows you to select a list showing base stations allowed to 
generate alarms, or base stations not allowed to generate alarms, or 
both

• List, displays:

— DMC TN, connected to a base station

— Radio Identifier, identifies the base station (1 to 4) 
connected to the DMC and the base station (1 to 8) 
connected to the DMC8

— Operational State, indicates if a base station is operational 
or is not operational

— Alarm Muted, indicates if a base station is allowed to 
generate alarms or not

— Number of Channels, identifies the base station as either a 
6-channel or a 12-channel base station

NOTE

You can view alarms on the OTM Alarm browsers (common services) or 
on the Active Alarm Snapshot window. (Figure 73)
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— Comment, an 80-character comment field in the DECT 
application 

• Pop-up menu, appears when at least one RFP is selected, and you right 
clicks the mouse. Selecting one or more a Radio Fixed Part 
(click/double-click on a Radio Identifier or highlight a row in the list) 
displays a menu with the following:

— Properties, (Figure 72)

• Help allows you to select Content and Index or About DECT application

Radio Fixed Part (base station) properties sheet

The Radio Fixed Part properties sheet is selected from the pop-up menu.

Figure 72
Radio Fixed Part (base station) properties sheet

What you can do with the Radio Fixed Part  properties sheet
This properties sheet allows you to:

• view base station details
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• view Operational Status. When base station operational status changes, 
the OTM server updates the status.

• change and apply Alarm Muting

• change and apply Comments, up to 80 characters

• select Line Power (powered by DMC) or Local Powered

• open the help file

• close the properties sheet

Radio Fixed Part properties sheet definition
The Radio Fixed Part properties sheet displays the same base station data as 
the Radio Fixed Part window list items. The properties sheet also shows the 
power source for the selected base station. 

Active Alarm Snapshot window

The Active Alarm Snapshot window is selected from the DECT Systems 
window Applications menu.

Figure 73
Active Alarm Snapshot window
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What you can do with the Active Alarm Snapshot
window

This window allows you to:

• connect to the Active Alarm Snapshot window

• refresh the window

• open a properties sheet

Active Alarm Snapshot window definition
The Active Alarm Snapshot window displays the alarm data stored in the 
DMC. The alarm data displayed does not change or update until manually 
refreshed.

• File, holds a pull-down menu allowing you to select one of the 
following:

— Connect / Lock / Unlock / Disconnect, same functions as the 
Connect/Disconnect tool

— Properties, opens the Active Alarm Snapshot, Figure 74

— Close, closes the Active Alarm Snapshot window

• View, holds a pull-down menu allowing you to select:

— Tool bar, to show or hide

— Status bar, to show or hide

— Refresh, updates the Active Alarm Snapshot window with 
the latest alarm data from the MDECT system selected in the 
title bar. You cannot select a separate DMC TN to refresh.

• Help, holds a pull-down menu allowing you to select:

— Content and Index

— About DECT application

• Tool bar, allows you to click the tool button to:
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—  connect,  lock,  unlock,  disconnect

—  Refresh, updates the Active Alarm Snapshot window 
with the latest alarm data from the MDECT system selected 
in the title bar. You can not select a separate DMC TN to 
refresh.

• List, shows read-only data about:

— Severity, always labeled as Critical

— Error Code, a three digit code. Refer to the Meridian 
Companion DECT Operation Administration and Maintenance 
NTP for the meaning of the Error Codes

— DMC TN, indicates the location of the card that originated 
the alarm

— Radio Identifier (base station identifier), indicates the base 
station that is the source of an alarm

— Date and Time, when the alarm occurred

— Operator Data, describes the alarm and the faulty 
component if applicable

• Pop-up menu, appears when at least one RFP is selected, and you right 
click the mouse.

— Properties, (Figure 74)

• Help displays Content and Index, and About DECT application

Active Alarm Snapshot properties sheet

The Active Alarm Snapshot properties sheet is selected from the pop-up 
menu.
553-3601-103 Standard 4.00 June 2001



 Optivity Telephony Manager for MDECT systems Page 129 of 158
Figure 74
Active alarm properties sheet

What you can do with the Active Alarm Snapshot  properties 
sheet
This properties sheet allows you to:

• view alarm (MDECT system message) details

• close the properties sheet

• open the help file

Active Alarm Snapshot properties sheet definition
The Active Alarm Snapshot properties sheet displays the same alarm data as 
the Active Alarm Snapshot window list items. 
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Performance Collection window

The Performance Collection window is selected from the DECT Systems 
window Applications menu.

Figure 75
Performance Collection window
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Figure 76
Select location

What you can do with the Performance Collection
 window

This window allows you to:

• start and stop User Performance Collection counters

• start and stop Equipment Performance Collection counters

Performance Collection window definition
The Performance Collection window displays the following:

• Name, allows you to select the directory where you want to store the 
Performance Collection file. 

• User Performance Collection, collects counter data on handset user 
related activities. 

• Equipment Performance Collection, collects counter data on DMC 
related activities. 
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Performance Collection additional information

The OTM MDECT Manager user starts and stops performance counter 
collection. You can not schedule performance collection. The collection 
begins when you start it and ceases when you stop it.

You can set the collection period for 15 minutes, 30 minutes, one hour, one 
day. The performance counters are on the DMCs. You can select DMC TNs.

You can collect User (handset) data and Equipment (MDECT system) data 
separately. You can set User (handset) data and Equipment (MDECT system) 
data collection periods separately.

The OTM MDECT Manager stores the performance files. Rebooting the OTM 
MDECT Manager does not destroy the files. The back up and restore 
application on the OTM MDECT Manager does not back up and restore the 
performance files.
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Retrieve RSSI Snapshot window

The Retrieve RSSI Snapshot window is selected from the DECT Systems 
window Applications menu.

Figure 77
Retrieve RSSI Snapshot window
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What you can do with the Retrieve RSSI Snapshot
 window

This window allows you to:

• view Radio Signal Strength Indication details

• scroll and select a DMC for RSSI information retrieval

Retrieve RSSI Snapshot window definition
The Retrieve RSSI Snapshot window collects, on request, the RSSI for 
selected DMC.

Retrieve RSSI Snapshot attributes

The OTM server collects the RSSI as an ASCII file. The OTM server user must 
indicate where to store the RSSI file.

Access the DECT application with a 
Web based navigator

For more detailed information on Web based navigators, see Using Optivity 
Telephony Manager for Meridian 1 (553-3001-330).

Open the Administrator Login

To open the Administrator login screen use the URL http:otm_server_name 
or use the ip_ address with either the Microsoft Internet Explorer Web 
browser or the Netscape Navigator Web browser.

Administrator Login

The Administrator Login is selected by clicking on the applet launch logo.
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Figure 78
OTM web Administrator login

The screen in Figure 78 is used to login to the OTM using the Web navigator.

Current Status

The current Status is selected by logging in on the previous screen.
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Figure 79
OTM web navigator current Status

The screen in Figure 79 gives the current status of:

• OTM software release version

• time and date of the last login

• OTM server applications

The current Status screen allows Web navigator access to the items listed on 
the left side of the screen.

System navigator

The System navigator is selected by clicking on System Navigator from the 
list on the left of the previous screen.
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Figure 80
OTM web system navigator

The screen in Figure 80 allows the selection of a MDECT system(s) to open 
the applications shown in the grey box on the left of the screen. Clicking on 
OTM DECT takes you to “DECT Systems window” on page 71. Clicking on 
Alarms takes you to “Alarm browser” on page 137.

Alarm browser

The Alarm browser is selected by clicking on System Alarms from the list on 
the left of the previous screen or Alarms in the gray box on the left of the 
System navigator screen.
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Figure 81
OTM web system alarms

The screen in Figure 81 allows you to examine system alarms.

Web Access security

The Web Access security is selected by clicking on Web Navigator Access 
from the list on the previous screen.
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Figure 82
OTM web access security

You can change Group individuals from the Windows NT User Administrator. 
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Multi-Site Mobility Networking
This chapter contains the following topics:

Operating parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 140

Feature interactions . .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 140
Call forward from a MADN handset . .  . . . . . . . . . . . . . . . . . . . . 140
Card audit . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 140
Network Message Service . .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 140

Feature packaging . .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 140

Multi-Site Mobility Networking (MSMN) allows a Companion DECT handset 
user to make and receive calls at any MCDN node. When the handset user 
visits a MCDN node the MSMN feature automatically:

• detects the visiting handset when it is on

• forwards calls to the visiting handset from the users home node

The call forward dial tone gives an indication when MSMN activation was not 
successful. The user can turn the handset off and on again to re-activate the 
MSMN feature.

The MSMN feature requires concentrated DMCs. The DMCs must be 8D to 
support concentration. A non-concentrated system has each handset 
configured to a DMC8 TN. A non-concentrated DMC8 has 32 handset TNs 
assigned to 32 time slots and is non-blocking. A concentrated system has 
each handset configured to a Virtual TN (VTN) on phantom loops. 
Concentration allows up to 510 handsets to share the DMCs 32 time slots 
and is a blocking system. See “Companion DECT Concentration Traffic” on 
page 143
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Separate DECT systems on a Meridian PBX can be either concentrated or 
non-concentrated.

Operating parameters
The MSMN feature can not support a mix of concentrated DMCs and 
non-concentrated DMCs within the same Companion DECT system.

All DMCs, either new, empty for redundancy, or used for base station 
coverage, must have at least one handset configured to ensure system 
operation.

The C4010/C4020 handset can subscribe to a maximum of eight DECT 
systems.

The C4040 handset can subscribe to a maximum of 10 DECT systems.

Feature interactions
Call forward from a MADN handset
A MADN handset at a remote node can activate call forward at the home 
node. When the handset shares a DN with another set(s), the CFW lamp 
lights on the shared DN set(s). If the handset is not the MARP, the shared 
DN MARP set can cancel call forward. If the handset is the MARP, the 
handset overrides any call forward which is setup from other shared DN 
set(s).

Card audit
Card audit does not work with VTNs.

Network Message Service
The MSMN feature does not change the handling of unanswered network 
calls. The Meridian Mail or Call Pilot network mail service does not change 
with multiple DNs configured against a single mailbox. The visiting DN 
receives the message waiting indication at the visited site.

Feature packaging
The MSMN feature requires the following packages:

• Multi-Site Mobility Networking (package # 370)

• M1 CT2 Mobility Option (package # 240)
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• Phantom loop (package # 254)

• Meridian Companion MC32 (package # 350)

• Flexible Feature Code (package # 139)

For details on installing and operating the MSMN feature, refer to the 
Meridian Companion DECT installation Guide.
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Companion DECT Concentration Traffic
This chapter contains the following topics:

System capabilities and limits . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 144
Blocking . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 144
Traffic definitions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 144
Traffic assumptions used for table calculations . . . . . . . . . . . . . . 144

Base station combinations for handsets on a DMC . . . . . . . . . . . . . . . . 146
Low traffic for a 0.1 Erlang capacity . .  . . . . . . . . . . . . . . . . . . . . . . 146
Medium traffic for a 0.15 Erlang capacity . .  . . . . . . . . . . . . . . . . . . 147
High traffic for a 0.2 Erlang capacity . . . . . . . . . . . . . . . . . . . . . . . . 148

Superloop and IPE shelf calculations . .. . . . . . . . . . . . . . . . . . . . . . . . . 149
Simplified guidelines . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 149

Low traffic example of one superloop
per IPE shelf . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 149
Medium traffic example of one superloop
per IPE shelf . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 149
High traffic example of one superloop
per IPE shelf . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 149

A Meridian DECT system without concentration supports a maximum number 
of 1024 handsets. With the concentration feature, in theory, the handset 
limit is 512 per DECT Mobility Card x 32 cards = 16384. However, in practice, 
traffic limits the number of handsets per card.

Each IPE card slot can support 32 channels of voice and data at the same 
time through the DS30X interface. Concentration removes the existing fixed 
ratio of 32 handsets per DMC.
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System capabilities and limits
Blocking
Calls in the DECT system can be blocked at many stages:

• At the base station: When all channels (6 or 12) of an base station are 
in use calls through that base station (both to and from a PP) are 
rejected.

• At the Backbone interface: When the base stations of one DMC’s 
together have 32 radio connections, calls through those base stations 
(both to and from a handset) are rejected.

• At the IPE backplane Interface: When all 32-speech channels to the 
DS30X interface on the a DMC8 are occupied, calls to and from handsets 
that have that DMC8 as their home-DMC8 are rejected.

• At the Network interface: Usually the IPE shelf connectivity is a 
blocking configuration where the number of network timelots provided 
for a Shelf is less than the actual number of terminals configured on that 
shelf.

Traffic definitions
Busy hour traffic: Busy hour traffic is the hour of the day during which a 
telephone system carries the most calls, voice or data. The unit for busy hour 
traffic is the Erlang or Centi Call Second (CCS).

Erlang: One Erlang is equal to the continuous use of a circuit for one hour.

CCS: (100 call seconds) One hundred call seconds or 100 seconds of 
continuous use of a circuit. Normally referred as CCS per hour. For example, 
a call on a circuit for one hour is equal to 36 CCS (60 minutes x 60 seconds 
= 3600/100 = 36 CCS).

 Blocking: Blocking is a condition when a telephone call does not complete 
and the calling party normally hears a busy signal.

Grade of Service: Grade of Service, given as a decimal fraction, indicates the 
probability of call blocking. For most applications, acceptable figures for 
blocking are between 0.01 and 0.03.

Traffic assumptions used for table calculations
A handset always has good radio contact with a Base Station, assumes that 
the radio deployment is acceptable.
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The Grade of Service used in all calculations is 1%.

Small or no overlap between Base stations. (In practice there is overlap, but 
to apply standard traffic calculations it is necessary to simplify the 
calculation). For example, where there are two 6-channel base stations in 
the same cell, they will deliver a higher traffic flow.

Ignore radio channels for handover. The traffic calculations allocate a 
slightly higher traffic capability to a base station than it can have in 
practice.

Blocking occurs at three main areas: the base stations, the backplane, and 
the network loops. The traffic calculations only use the Erlang values where 
blocking occurs. For example, if there are three areas each delivering 10 
Erlangs, traffic calculations take the total traffic capability as 10 Erlangs, 
not as 30 Erlangs. (Real traffic capacity for this example is possibly more 
than 10 Erlangs.)

Handset handover continues without interruption.

Handsets are distributed equally between the system DMCs.

All calculations are based on resident handset users. Visiting handset users 
have a negligible effect on traffic. In unusual circumstances where a site has 
a large number of visiting handset users, traffic capacity can require 
adjustments.
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Base station combinations for handsets on a DMC
Low traffic for a 0.1 Erlang capacity

Table 5 shows the 6-channel and 12-channel base station combinations 
required to support a maximum number of handsets on a DMC. The 
calculations are based on each handset generating 0.1 Erlangs of traffic.

Table 5 Number of handsets for a 0.1 Erlang capacity

Number of 12-channel Base Stations

0 1 2 3 4 5 6 7 8

Number 0 0 58 117 176 220 220 220 220 220

of 1 19 77 136 195 220 220 220 220

6-channel 2 38 97 155 214 220 220 220

Base 3 57 116 174 220 220 220

Stations 4 76 135 194 220 220

5 95 154 213 220

6 114 173 220

7 133 192

8 152
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Medium traffic for a 0.15 Erlang capacity
Table 6 shows the 6-channel and 12-channel base station combinations 
required to support a maximum number of handsets on a DMC. The 
calculations are based on each handset generating 0.15 Erlangs of traffic.

Table 6 Number of handsets for a 0.15 Erlang capacity

Number of 12-channel Base Stations

0 1 2 3 4 5 6 7 8

Number 0 0 39 78 117 146 146 146 146 146

of 1 12 51 91 130 146 146 146 146

6-channel 2 25 64 103 143 146 146 146

Base 3 38 77 116 146 146 146

Stations 4 50 90 129 146 146

5 63 102 142 146

6 76 115 146

7 89 128

8 101
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High traffic for a 0.2 Erlang capacity
Table 7 shows the 6-channel and 12-channel base station combinations 
required to support a maximum number of handsets on a DMC. The 
calculations are based on each handset generating 0.2 Erlangs of traffic.

Table 7 Number of handsets for a 0.2 Erlang capacity

Number of 12-channel Base Stations

0 1 2 3 4 5 6 7 8

Number 0 0 29 58 88 110 110 110 110 110

of 1 9 38 68 97 110 110 110 110

6-channel 2 19 48 77 107 110 110 110

Base 3 28 58 87 110 110 110

Stations 4 38 67 97 110 110

5 47 77 106 110

6 57 86 110

7 66 96

8 76
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Superloop and IPE shelf calculations
Table 8 shows the maximum number of handset users on a DMC8 for varying 
traffic levels. This table includes the Option 11, with its non-blocking 
system architecture.

Table 8 Handset capacity/DMC8 for Superloop/IPE

Simplified guidelines
Use Figure 8 to calculate the superloop capacity. 

Low traffic example of one superloop
per IPE shelf
69 handsets per DMC8 x 16 DMC8 per shelf = 1104 (1000)

Medium traffic example of one superloop
per IPE shelf
46 handsets per DMC8 x 16 DMC8 per shelf = 736 (750)

High traffic example of one superloop
per IPE shelf
34 handsets per DMC8 x 16 DMC8 per shelf = 544 (500)

Superloops for 
each IPE shelf

Low traffic 
0.1 Erlang

Medium traffic 
0.15 Erlang

High traffic 
0.2 Erlang

2 138 handsets/DMC 92 handsets/DMC 69 handsets/DMC

1 69 handsets/DMC 46 handsets/DMC 34 handsets/DMC

0.5 34 handsets/DMC 23 handsets/DMC 17 handsets/DMC

Option 11 220 handsets/DMC 146 handsets/DMC 110 handsets/DMC
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Companion Alarms Response System
This chapter contains the following topics:

Introduction . .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 151
How CARS works . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 152

Basic CARS feature . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 152
Optional CARS feature . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 153
Escalation DN . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 153

Introduction
The Companion Alarms Response System (CARS) is an alarm notification and 
response application. The CARS application runs on a Windows NT™ PC 
connected to a Large system or Small system.

The CARS application provides warning of an external alarm event. The alarm 
triggers a signal to call a Companion cordless handset user. CARS provides 
text messages and voice prompts to the handset user. The handset user can 
acknowledge the alarm and can start a remote response.

The CARS application can process up to 24 external alarm inputs. Each alarm 
input can establish an alarm call to a telephone.

CARS operates with both DECT and CT2 versions of Meridian Companion. 
CARS is also compatible with alphanumeric display desktop telephones on 
Large system and Small system.
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Figure 83 Main parts of the Companion Alarms Response System

How CARS works
Basic CARS feature

The CARS application alerts a handset user of an alarm occurrence. The alarm 
originates from a device, for example, a fire door opening or a machine 
failing. The device sends an electrical signal to an alarm port on the 
input/output card. The electrical signal changes a condition on the alarm 
port. Each alarm port has an associated handset DN (Primary DN).

Input/Output
control cards

CARS
Alarms Server

VPS-DSE
card

DMC

Base Station

Meridian PBX
NTMF94DA
cable E-LAN
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The port condition change causes the CARS Alarm Server to send the ports 
Primary DN to the Voice Processor Server-Digital Set Emulation (VPS-DSE) 
card. The VPS-DSE card calls the Primary DN handset and sends a CPND alarm 
message to the handset.

The handset rings and displays the CPND to notify the handset user that an 
alarm occurred. The handset user answers the call. A voice prompt from the 
VPS-DSE card describes the alarm and asks the user to enter a PIN code.

The handset user acknowledges the alarm by entering the correct PIN code 
digits. The correct PIN code returns the port to its inactive state condition, 
causing CARS to consider the alarm cleared.

The CARS application records handset user action or user inaction.

Optional CARS feature
CARS provides two optional features, as follows:

• Remote Response

• Transfer

Remote Response

After acknowledging the call, the handset user can press 1 then # to activate 
a remote response. When the handset user presses 1 #, a relay on the 
input/output card activates. The relay connections provide for a remote 
action. The relay remains activated until the handset user terminates the 
call or transfers the call.

Transfer

After acknowledging the call, the handset user can press   2 then # to 
activate a call transfer to a earlier specified DN. When the handset user 
transfers the call, CARS considers the alarm cleared. The handset user can 
transfer the alarm call to any DN using the PBX features for Call Transfer.

If the user selects the wrong option, a voice prompt warns the user of the 
wrong option selection.

Escalation DN
An Escalation DN is a backup for the Primary DN. The alarm call routes to the 
Escalation DN, for the following reasons:

• a wrong PIN code
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• a timed-out PIN code

• a busy Primary DN

• a timed-out Primary DN

If the user enters a wrong PIN code, the alarm prompt plays again. The user 
gets three tries to enter the code. After three wrong entries, the call 
escalates. An option allows either using a PIN code or the # key to 
acknowledge the alarm.

An escalated call continues to ring the Escalation DN until answered, 
although the input signal can return to normal.

All handset digit entries must end by pressing the # key.

For detailed information, refer to the Companion Alarms Response System 
Installation Guide. 
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Figure 84  CARS operation chart
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Meridian Companion DECT 
provisioning records

The DECT provisioning records include the following:

• a System information record

• a Provisioning information record

• an Installation record

• a System programming record

• a Portable user information record

Keep a copy of these records at the customer site. Vendors 
maintaining the DECT system also need a copy of the records.
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